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Agenda
1. Intro to digital accessibility

2. Content accessibility best practices

a. Images and visual design

b. Text content: document structure and design

3. Slide accessibility

4. PDF accessibility

Breaks will be built in every hour!



Session Objective

The purpose of this session is to 
understand best practices for 
creating accessible digital 
content, regardless of editing 
platform.



What is Digital Accessibility?

All people should have the opportunity to access 
the same information and services in the digital 

environment without facing undue barriers or burdens.



How to Approach Digital Accessibility Work

● Proactive and Reactive approaches:
○ Reactive: Waiting for a person with a disability to ask for 

an accommodation.

○ Proactive: Anticipating access needs, and making content accessible in 
advance.

○ NOTE: Zero accommodations is not the goal!

● Take time to learn accessibility habits and skills and implement 
proactive accessibility practices one at a time.



Images & 
Visual Design



Images and Visual Design Practices

1. Alt Text (current topic)

2. Visual Style as Meaning

3. Color Contrast



What is Alt Text?

● Text that conveys the meaningful content of an image concisely 
to someone who can’t see it.

● Not visible in your document; read by assistive technology.

● If it’s not present, the file name is read.



How to Write Alt Text
● Should be short (~150 characters).

o Prioritize accurate descriptions over character limit.

● It should only describe what can be seen in the image.

● Start with the most important information; omit “image of.”

● Alt text varies depending on the context in which an image is used.
o Should be a neutral description, not commentary.

● Avoid using automated tools to generate alt text.

● To practice writing alt text, ask yourself, "how would I describe this 
image to a friend over the phone?"



How to Write Alt Text (2)
● Some images have no meaningful 

content.

○ Mark as a “decorative image”

○ Will not be read by assistive 
technology.

● Google Docs does not allow for 
decorative images (Google Docs 
limitations).

Screenshot from Microsoft Word

https://www.colorado.edu/digital-accessibility/google-docs-and-accessibility#:~:text=creating%20your%20document.-,Decorative%20Images,-Avoid%20the%20use
https://www.colorado.edu/digital-accessibility/google-docs-and-accessibility#:~:text=creating%20your%20document.-,Decorative%20Images,-Avoid%20the%20use


Identity in Alt Text

● Is the subject’s race, gender, disability, 
skin color, ethnicity, age, etc. essential to 
understanding the image in its context?

● If the subject is a known individual, use 
the language they use to describe 
themselves.

● Identity in Alt Text Resource
Possible alt text: “A group of activists with varying 
disabilities, racial identities, genders, and age 
demographics holding a sign that reads ‘Injustice 
anywhere is a threat to justice everywhere. Martin 
Luther King Jr.”

https://www.colorado.edu/digital-accessibility/identity-and-inclusion-alt-text


Applying Alt Text in Your Work

● Describe the images in the body of your content even if you can't add 
alt text.

● How to add alt text to specific platforms:

○ Microsoft Office

○ Google Suite

○ Outlook

○ Canvas

https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669?ui=en-us&rs=en-us&ad=us
https://support.google.com/docs/answer/6199477?hl=en
https://support.microsoft.com/en-us/office/video-improve-image-accessibility-in-email-e93969e3-21c1-47ad-a4c5-0e5fb868a7f8
https://oit.colorado.edu/services/teaching-learning-applications/canvas/canvas-accessibility/canvas-rich-content-editor#:~:text=Images%20%26%20Multimedia,in%20the%20content%20editor%20toolbar.


Images and Visual Design Practices

1. Alt Text

2. Visual Style as Meaning (current topic)

3. Color Contrast



What is Visual Style?

• Visual style refers to any visual 
formatting of content that includes the 
use of color, italics, bolding, 
underlines, and punctuation.

• Style is helpful for some people to 
access content!

• Style should never be used as the only 
way to convey meaning.



Visual Style as Meaning Example - Color

Inaccessible Example:
Can I touch that plant?

● Aloe vera

● Poison ivy

● Poison oak

● Violets

Accessible Example:
Can I touch that plant?

● Aloe vera (yes)

● Poison ivy (no)

● Poison oak (no)

● Violets (yes)



Not Relying on Visual Style Alone in Your Work

● If something is vital in your communications, ensure you're making 
that clear to all potential viewers.

○ Always supplement color-coded information with text explanations. Use 
words like "Important" in front of objects that are vital to know.

● Reserve underlining for links only.

● Avoid cluttered or scattered content. Use whitespace around sections 
or objects to help visual grouping.



Images and Visual Design Practices

1. Alt Text

2. Visual Style as Meaning

3. Color Contrast (current topic)



Color Contrast
● Color contrast is the difference in brightness between 

foreground and background colors.

○ You can’t always tell what has sufficient contrast with your eyes 
alone.

● The Colour Contrast Analyser software is a free color contrast 
checker that allows you to easily determine the contrast ratio 
of two colors simply using an eyedrop tool or inputting the 
HEX code.

● The WebAIM Contrast Checker is a free web-based 
application you can use to check for sufficient color contrast.

https://www.tpgi.com/color-contrast-checker/
https://webaim.org/resources/contrastchecker/


Colour Contrast Analyser (CCA)



Text Content: 
Document 
Structure & 
Design



Text Content Practices

1. Images of Text (current topic)

2. Headings

3. Link Text

4. Lists

5. Tables



Images of Text
● Images of text are typically digital flyers/posters 

or photocopied documents of text and are 
inaccessible.

● Can you select the text?

● CU Denver uses SensusAccess to convert 
images of text using optical character recognition 
to make text selectable.

○ Note: this does not guarantee accessibility, but is 
a good "just in time" option.

https://www.ucdenver.edu/tips/teaching-innovations/academic-technology-training/sensusaccess#:~:text=SensusAccess%20is%20a%20self%2Dservice,them%20into%20more%20accessible%20formats.
https://www.ucdenver.edu/tips/teaching-innovations/academic-technology-training/sensusaccess#:~:text=SensusAccess%20is%20a%20self%2Dservice,them%20into%20more%20accessible%20formats.


Text Content Practices

1. Images of Text

2. Headings (current topic)

3. Link Text

4. Lists

5. Tables



What are Headings?

● Organize and structure your 
content hierarchically.

● Must be programmatically 
applied as a style or “tagged” in 
your editing program.

● Do not mimic a heading by 
using visual style such as text 
size, bold, or underline.

● Use familiar heading designs.



Heading Level Breakdown
● Heading 1: H1 is broadest topic or document/website title. Generally only 

have one H1 in a document.

● Heading 2: H2 is used to introduce the main topics of your doc/website. 
You can have multiple H2s through H6s.

● Heading 3: H3s are subtopics related to your H2 used to help further 
breakdown your content.

● Heading 4: H4s are subtopics related to your H3.

● Heading 5 & 6: Subtopics related to your H4/H5. Do not exceed H6 in 
your content as screen readers cannot read further than H6.



Heading Levels

● Only increase level by +1 
at a time as you increase 
specificity of headings.

● You may decrease by more 
than one heading level at a 
time.



Headings & Slide Titles

● In both PowerPoint and Google Slides, slide titles are read as 
headings.

● Every slide should have a unique title.

○ If you have the same heading for multiple slides, add a number or 
word to create a unique title. For example, "Heading Levels (2), 
Heading Levels Continued"



Applying Headings in Your Work

● How to add headings on specific content editing platforms:

○ Headings in Microsoft Word (video)

○ Headings in Google Docs

○ Headings in Canvas Pages

○ Headings in WebExpress

○ Headings in HTML

https://support.microsoft.com/en-us/office/video-improve-accessibility-with-heading-styles-68f1eeff-6113-410f-8313-b5d382cc3be1?ui=en-us&rs=en-us&ad=us
https://support.google.com/docs/answer/116338
https://oit.colorado.edu/services/teaching-learning-applications/canvas/accessibility/accessible-content-structure
https://websupport.colorado.edu/article/362-headings
https://webaim.org/techniques/semanticstructure/#headings


Text Content Practices

1. Images of Text

2. Headings

3. Link Text (current topic)

4. Lists

5. Tables



What is Link?
● Link text is using words in place of 

a URL to make it easier to 
determine where a link is taking 
someone.

● Screen readers can jump from link 
to link to navigate quickly through 
a page.

● Links should make sense outside 
of their context in the document.



Link Text Best Practices

● Describe the destination concisely in link text; avoid “click here”.

● Identify the destination file type in the link text if it’s not a web page.

○ Example: CU Boulder Digital Accessibility Standards (PDF).

● Avoid duplicate link names unless they go to the same destination.

● Don’t write out full URLs unless they’re meant to be memorized.

https://www.colorado.edu/digital-accessibility/sites/default/files/attached-files/digital_accessibility_campus_standards_-_2020_updated_july_2022.pdf


Link Text: Describe the Destination

Click here to visit the beach. Click here to visit the 
dump.



Link Text: Describe the Destination (2)

Click here Click here 



Link Text: Describe the Destination (3)

Visit the beach Visit the dump



Text Content Practices

1. Images of Text

2. Headings

3. Link Text

4. Lists (current topic)

5. Tables



Lists

● Use the List creation button!

● When you press Enter, if it 
automatically indents and 
creates the next list item, you’re 
doing it right.

● Avoid too many levels of 
indentation in a list.



Text Content Practices

1. Images of Text

2. Headings

3. Link Text

4. Lists

5. Tables (current topic)



Tables
● Avoid using tables for layout purposes.

○ Tables should only contain data.

● Add a caption, if needed.

● Avoid merged cells & complex tables.

● Avoid empty data cells, with the exception 
of cell A1 if you have column and row 
headers.

data table

2010 2011 2012 2013

Expenses $50 $58 $79 $83

Income $202 $300 $290 $249

layout table



Table Headers
● Table headers are cells that describe the 

data in its column or row.

● You must tag (or programmatically apply) 
table headers in your content editing platform 
rather than mimicking them with visual styles.

● Column headers are generally required 
whereas row headers are generally nice to 
have. This depends on your table layout.

● Repeat column headers if they continue onto 
multiple pages.

column headers

row headers



User Experience Example
If you read the second row of the accessible table below with a screen reader, 
navigating from cell to cell, the screen reader will read:

"Jeremiah, Monday 78, Tuesday 56, Wednesday 42, Thursday 23."

If headers are not tagged appropriately, a screen reader will read:
"Jeremiah, 78, 56, 42, 23."

Number of minutes at the gym, by day of week

Monday Tuesday Wednesday Thursday

Jeremiah 78 56 42 23

Ariel 74 50 54 33



Additional Slide Accessibility Practices



Reading Order
● Reading order determines the order in which assistive technology, 

specifically screen readers, will read content on each slide.

● Setting the Reading Order:

○ Allows text-to-speech or screen reading software to read 
information sequentially, typically left to right, top to bottom.

○ To test the reading order on either PowerPoint or Google Slides, place 
your cursor on your slide (outside of any elements on the slide), then 
press the Tab key. The order in which the elements are selected is the 
order in which they appear to assistive technologies.



Rearranging Reading Order in Google Slides

If you need to change the order of an element, in the main menu, select 
Arrange, or select any element, right-click (or Shift + F10) to open the 
drop-down menu, hover over the Order submenu to see the options for 
movement of the element.



How to Rearrange Reading Order in Google Slides

● Send to back places the element at the top of the reading order, 
making it first to be read by a screen reader (Ctrl + Shift + down arrow).

● Bring to front places the element at the bottom of the reading order, 
making it last to be read by a screen reader (Ctrl + Shift + up arrow).

● Send backward moves the element higher in the reading order (Ctrl 
+ down arrow).

● Bring forward moves the element lower in the reading order (Ctrl + 
up arrow).



Rearranging Reading Order in Microsoft PowerPoint

● Reading Order Method: 
Each content element should 
be organized from top to 
bottom (opposite of the 
Selection Pane process) so 
assistive technology can read 
it in its logical reading order.

○ Only available in PPT 
desktop version.

● Selection Pane Method: 
Each content element 
should be organized from 
bottom to top (opposite of 
the Reading Order process).

○ Available in PPT's online 
and desktop version.

https://nam10.safelinks.protection.outlook.com/?url=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fvideo-create-slides-with-an-accessible-reading-order-794fc5da-f686-464d-8c29-1c6ab8515465%23%3A~%3Atext%3DModify%2520the%2520reading%2520order%26text%3Dto%2520bottom%2520order.-%2CSelect%2520Review%2520%253E%2520Check%2520Accessibility%2520%253E%2520Reading%2520Order%2520Pane.%2Cthe%2520objects%2520in%2520the%2520list.&data=05%7C02%7Callyson.bartley%40colorado.edu%7C8221c9aae3e0487384f708dc4e72081a%7C3ded8b1b070d462982e4c0b019f46057%7C1%7C0%7C638471498882590494%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=LvUE8zgIyJNv3AIoMDcCnDObaZuIisqd482dkrhGJcc%3D&reserved=0
https://nam10.safelinks.protection.outlook.com/?url=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fpowerpoint-check-reading-order-4ae4eea6-431c-4b64-b6df-59298170d6a1&data=05%7C02%7Callyson.bartley%40colorado.edu%7C8221c9aae3e0487384f708dc4e72081a%7C3ded8b1b070d462982e4c0b019f46057%7C1%7C0%7C638471498882610965%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=etkr0MJPgWrcCllLBEKw4%2FO44ht090GPW4GFtqIqeCQ%3D&reserved=0


Thinking About 
PDF Accessibility



Scope of PDF Training

● PDF accessibility is complicated, but not impossible.

● We won’t teach you every important detail in checking a PDF for 
accessibility during today’s session.

● The things we’ll cover will give you a high level sense of the 
accessibility of a PDF document.



Disadvantages:
● Requires purchased software 

and knowledge to edit.

● Requires form fields to allow 
users to enter information.

● Requires significantly more time, 
effort, and knowledge to make 
accessible than other file types.

Advantages:
● Easily opened on any device.

● Doesn’t require purchased 
software to access.

● Layout and formatting is 
consistent across all devices.

Pros and Cons of PDFs



First Rule of PDFs:
Ask yourself "does this need 

to be a PDF?"



Could your PDF be a different document type?
● Do you need a consistent visual 

layout on all devices?

○ PDF, HTML

● Does the document need to be 
available to people outside the 
university?

○ PDF, HTML

● Is the document frequently updated?

○ HTML, Word, PPT

● Will users need to type in the 
document?

○ Word, Google Docs, PPT

● Do you need form fields?

○ Web Express forms, Google 
Forms, Qualtrics

● Does the document need to be 
printed?

○ PDF, Word, PPT



How to Create Accessible PDFs

● Two main ways PDFs 
are created:

1. Scanning a document as 
an image.

2. Exporting to PDF from 
a source document.

● Scanned images are not accessible! 
You will need to convert the images to 
digital text. OCR Platforms included:
○ Google Docs (free)

○ Adobe Acrobat (cost)

○ Abbyy FineReader PDF (cost)

○ Kofax OmniPage (cost)

○ ClaroPDF (cost)

https://support.google.com/drive/answer/176692?hl=en&co=GENIE.Platform%3DDesktop
https://www.adobe.com/acrobat/how-to/ocr-software-convert-pdf-to-text.html
https://pdf.abbyy.com/pricing/
https://www.tungstenautomation.com/products/omnipage
https://apps.apple.com/us/app/claropdf-pro-text-to-speech/id633997623


● Source document: the file from which you export to PDF (Word, 
InDesign, PowerPoint, etc.)

○ Make your source document as accessible as possible before exporting to 
PDF.

● You may have to export in a particular way to preserve accessibility 
features; this may vary by content editing platform.

○ How to preserve accessibility when converting from Word to PDF

○ How to preserve accessibility when converting from Google Docs to PDF

How to Create Accessible PDFs (2)

https://webaim.org/techniques/acrobat/converting#save
https://www.colorado.edu/digital-accessibility/google-docs-and-accessibility#:~:text=Google%20Doc%20to%20PDF%20Conversion


How to Create Accessible PDFs (3)

● Iterate between source document & PDF:

○ Find issues in PDF using the Acrobat Accessibility Checker.

○ Fix issues in the original platform, re-export to PDF.

○ Continue until PDF is as accessible as possible.

● Unless you've completed PDF accessibility training, we 
recommend avoiding PDF remediation as much as possible.

○ Remediation: adding or adjusting accessibility features in 
Acrobat Pro after the PDF has been created.

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#:~:text=Check%20accessibility%20of%20PDFs%20(Acrobat%20Pro)


● Get the source file if at all possible.

● If you don’t have the source file, we recommend exporting to 
Word or manually recreating the document.

○ Export to Word from Acrobat Pro by:

■ File > Export To > Microsoft Word > Word Document

● Recreating or exporting the document can save time in the long 
run and allows future edits to be made.

Inherited PDFs



Let's Practice



Practice Document

Do not edit this document. You must download your own 
copy before editing!
Accessibility Practice Document

1. Select the link to open the document
2. File > Download
3. Download as Microsoft Word (.docx)
4. Open in MS Word desktop application
5. Select Enable Editing

https://docs.google.com/document/d/1Hpg7kEyN8Idg1hnhFHKanKsw4Er2Tyh4LGkIbuhUIcA/edit?usp=sharing


Additional Resources



Additional Resources

● Canvas Accessibility Checklist
● Subscribe to our Digital Accessibility Newsletter

● DAO Self-Paced Resources

● Follow the DAO on LinkedIn

● Accessibility Fundamentals for Digital Communicators - system-wide

● Virtual Office Hours - Fourth Tuesday of each month from 1 to 2 PM

https://docs.google.com/document/d/1OtNX4SxydtghTht-SSU3D6M49ykZJm__/edit?usp=sharing&ouid=107265149905024146382&rtpof=true&sd=true
https://cu.tfaforms.net/329
https://www.colorado.edu/accessible-technology/resources
https://www.linkedin.com/company/digital-accessibility-office/
https://nam10.safelinks.protection.outlook.com/?url=https%3A%2F%2Fshare.percipio.com%2Fcd%2FQttYPe3wB&data=05%7C02%7CAllyson.Bartley%40colorado.edu%7Ca55ec32670a2459658ef08dcd756eb8a%7C3ded8b1b070d462982e4c0b019f46057%7C1%7C0%7C638622015545470183%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=teZ3A1MFd6%2F8LLT37DqZteQMC8IUDRV%2BVMLi1bB0uaU%3D&reserved=0
https://www.colorado.edu/digital-accessibility/office-hours


Microsoft Word: Accessibility Checker 

● Review > Check Accessibility
● The Accessibility checker is a nice high 

level view and can help you keep 
accessibility in mind when creating 
content.

● Accessibility checkers are not a 100% 
guarantee that your document is fully 
accessible. There are many 
accessibility problems an automated 
checker will fail to identify and will 
require a manual check.

Mac screenshots



Working with People with Disabilities

● Many disabilities are invisible.

● Not all people report having a disability in the classroom / workplace.

● It’s okay to ask someone what they need (captions, extended deadlines, 
etc.), but it is never okay to ask someone what their disability is.

● What may work for one person may not work for another, even if they 
have the “same” disability.

● People’s lived experiences of their disability vary widely.



Contact Us

Digital Accessibility Office
DigitalAccessibility@Colorado.EDU



Thank you!

Please provide feedback on the 
training you received today - 

feedback survey

https://docs.google.com/forms/d/e/1FAIpQLSdN8kF5Y2EEiAs3r8O9XPfzNVFNyz2Tt6gC3Pc99MtBkXqoxA/viewform?usp=sf_link

